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Chapter 14 – File management 
SAVING WORK 

When you are creating digital products, it is important that you save your work regularly. This is to make sure that 

you have a copy of your work in case the application crashes or you lose power to your computer. This should 

include saving your work frequently to secondary storage.  

SECURING FILES 

You can secure your files by adding a password to be able to read or edit the file, as shown in Figure 14.1. 

 

NAMING FILES 

It is important to use sensible filenames. A sensible filename describes the contents of a file so that it can be found 

easily. 

 

The following points are some of the considerations that will help you to decide on a good filename. 

 

• You might choose to name it Poster. However, you might make more posters later. 

 

• You could name it First Poster, to be followed by Second Poster, third poster and so on, but in the future 

you may not remember what Second Poster referred to. 

 

• You could name it Sports Club Poster, but what would happen if you were asked to create a different 

sports club poster in the future? What if you needed to create more than one poster for the same club? 



www.focuscollege.lk  +94 74 213 6666  
   

3 
 

If you need to use more than one word in your filename, you should not use spaces between the words. This is 

because the spaces can cause problems with some software. Instead, you can use snake case.  

 

 

 

 

 

VERSIONING 

As you make changes to a file, you can name it with a version 

number. This is known as versioning, and it allows you to return 

to earlier versions of the same document at a later date.  

 

You could also include the date in your versioning by using the 

format MAJOR. REVISION.BUILDdate.BUILDnumber. For example, 

1.2.161226.5 specifies the following information. 

■MAJOR: version 1 

■REVISION: 2 

■BUILDdate: 161226 (26th December 2016)  

■BUILDnumber (from that BUILDdate): 5 

 

FOLDERS 

You can use a folder structure to keep your folders and files organised. This ensures that your files remain organised 

and also lets you know what type of documents are inside the folder. In turn, the Posters folder could be placed 

inside a folder called Word Processed Documents, as shown in Figure 14.4. 
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FILE FORMATS 

Software applications can only read files that are saved in compatible formats. For example, presentation 

applications cannot open files saved in a format used by spreadsheet applications. It is good practice to save your 

files in a format that will be compatible with the software that you will use to edit it. When saving files, you can 

choose to save them in different formats.  
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Chapter 15 – Word processing 
ENTER AND EDIT TEXT 

When you open a word processing application, it will open a new document or 

ask you to choose a type of document to open. When you type into the document, characters will appear beside 

the cursor. 

The I-beam (sometimes called the I-cursor) is the mouse cursor that you can use to choose the insertion point for 

text or to highlight text to edit or format. 
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SPELLING, PUNCTUATION AND GRAMMAR (SPAG) 

To help you check your spelling, punctuation and grammar, you can use automated checking tools to proofread 

your work as you type. 

 

In Figures 15.6 and 15.7, the automatic checking tools in Microsoft® Word and LibreOffice Writer indicate that 'thi' 

is misspelled. You can see that both applications indicate the misspelling with red underlining. Both applications 

also indicate a grammatical error ('a' instead of 'an') with blue underlining. 

 

Neither tool highlights the incorrect use of the word 'muse', which should read 'mouse', because 'muse' is also a 

word that is spelled correctly. This is one reason why it is important to proofread your work yourself, rather than 

only relying on checking tools, because automated systems will not pick up all 

errors. 

 

 

FORMATTING 

You can use a range of effects to change the appearance of your document. Word processing software usually 

provides a number of formatting tools, as shown in Figure 15.9. 
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PARAGRAPH FORMATTING 

Paragraph formatting affects the layout of the document. 

BULLET POINTS 

To emphasise key points in your document, you can use bullet points. Bullet points are set out as a list, with each 

point on a separate line, preceded by a symbol. Usually this symbol is a filled-in circle, but you can use many 

different symbols including squares, arrows and ticks or crosses. 

 

 

NUMBERING 

Numbering is used for ordered lists, either when it is important to show a numerical order or to show that some 

items take priority over others. Numbering can use numbers (1, 2, 3, 4), letters (a, b, c, d), and Roman numerals (i, 

ii, iii, iv). 

 

 
 



www.focuscollege.lk  +94 74 213 6666  
   

9 
 

Alignment  

Alignment refers to the position in which text appears on the page. For 

example, text can be aligned so that it starts on the left page margin or so 

that it finishes on the right page margin. This is done using the alignment 

buttons shown in Figure 15.14. 
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TABS (INDENTATION)  

You can use tabs to move text away from a margin or to produce standardised spacing between text. 

 

LINE SAPCING  

You can change the line spacing of your document if you want to add more 

space between the lines of text. This can improve the readability of the 

document and provides space for people to make hand-written notes in 

between the lines of your text when printed. 

 

TEXT WRAP 

When you reach the right page margin at the end of a line, word processing software will move the last word to the 

next line if it is too long to fit on the current line. This is called text wrap and is shown in Figure 15.20. 

 

FONT FOMMATING  

Font formatting affects the appearance of the text in your document. 

COLOUR 

You can change the colour of the text using the tools listed in the Format or Font 

menu, as shown in Figure 15.21. 
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FONT SIZE AND STYLE 

The text that you enter can be made larger or smaller by altering the font size, as shown in Figure 15.22. Using 

different font sizes is useful if you are trying to show a visual hierarchy, in order to make some items in a document 

look more important than others. 
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Text boxes  

You can use a text box to place text in a precise location on the 

page. The text box creates a moveable and resizable area of a 

document that has its own margins, as shown in Figure 15.24. 

 

COLUMNS 

You can choose to have your lines of text laid out in vertical columns, rather than running all the way across the 

page. This is the sort of layout you generally see in newspapers and newsletters. 

When you want text from the first column to move up into a second one, you can use a column break from the 

Breaks menu. 

 

TABLES 

Another way to arrange text in a document is by using tables. 

Tables are useful for displaying comparisons between different 

pieces of text. Like columns, they keep the text aligned but 

have more features than columns. 

A table is made up of rows and columns of cells. For example, in the table shown in Figure 15.27, the red-shaded 

area is a row of four cells. The area with thick borders is a column of three cells. 
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Alignment  

Just like the body text on a page, the text in cells can be 

aligned left, right or centre, or it can be justified. Text can 

also be aligned to the top, the middle or the bottom of a 

cell. 

Merge  

You can merge different cells together to form one large 

cell. This is useful for 

creating headings in tables, as shown in Figure 15.31. 

 

 

 

Split  

In some word processing applications, you can also split cells in a table. Cells can be split vertically and horizontally, 

as shown in Figure 15.32. 
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Gridlines  

Some word processing applications have a gridlines feature that makes the table layout visible while you are 

working with it. However, the gridlines are not printed or shown when the final version of a document is exported.  

 

Borders  

Unlike gridlines, borders are visible when the document is printed or 

published. You can change the thickness and colour of the borders. Some 

word processing applications allow you to add patterned borders or 

repeated images to create a patterned border. 

Shading 

You can use shading to apply different colours to different cells. For 

example, some of the cells in Figure 15.34 are coloured in order to 

highlight cells that have been merged or split. Similarly, in Figure 15.36, 

some cells are highlighted to make the table easier to read. 

PAGE LAYOUT 

Heading and subheading  

The page layout relates to how content is positioned on the page. 

To make the layout of your document consistent, you can use heading and 

sub-heading styles. These styles can be applied to heading text in order to 

apply a particular font style, size, formatting and colour to headings throughout a document. Figure 15.39 shows an 

example of heading styles. 
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Lists  

You learned about bullets and numbering on pages 213-215. 

Templates  

You can create documents using an existing template. Using a template 

gives your documents a consistent style. In a business or organisation, 

this consistency is known as a house style. For more information about 

house styles, see Unit 5 Applying Information and Communication 

Technology (pages 188-189). 
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Header and footer  

The header is the area at the top of a page in a document. It can contain text or 

graphics. The footer is the area at the bottom of a page that can also contain text or 

graphics. 

 

The content in the header and footer is usually repeated on every page. 

Common content for headers and footers includes the title of the document, the 

author's name, page numbers and the date and time when the document was created or modified. 

 

Page breaks  

If you want to start a new page, such as for a new section or chapter in a document, you can insert a page break. 

This can be done using the mouse to select the Breaks menu or using the keyboard by pressing Ctrl+Enter on a 

Windows® PC or Command+Enter on an Apple® Mac®. 

 

Inserting a page break ensures that the gap at the bottom of 

the page on which the page break is inserted will be In this 

case, if you add text at the end of the first page, the text on 

the next page may be pushed down to accommodate all the 

line returns. 

The orientation of a document affects the layout of the 

document. There are two orientations, as shown in Figure 

15.48: 

 

■portrait, with the long side of the page vertical like a portrait 

painting 

■landscape, with the long side of the page horizontal, like a 

landscape painting. 

 

The default page orientation is portrait. 
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Page numbering  

Page numbers can be included in the footer as a repeated 

element that appears on every page. They can be set to 

automatically increase as the document gets longer. 

 

 
These document elements include: 

■charts and values from spreadsheets 

■tables (see page 220) 

■images, including screenshots 

■videos, as shown in Figure 15.53 

■shapes, as shown in Figure 15.54, including lines, geometric shapes, arrows, mathematical shapes, flow chart 

symbols, stars and banners and callouts 

■text from other files, usually by copying it and then pasting it into your document text boxes (see page 219). 
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DOCUMENT TYPES 

Word processing software can be used to create a number of 

different types of document, including letters and posters. 

Letters  

When creating letters, it is a convention to start the document 

with a salutation and end it with a complimentary close. Table 

15.4 contains examples of salutations and corresponding 

complimentary closes. 

 

REPORT 

A report is a formal document that is used to bring together and 

present information about a specific topic. To help present the 

information as clearly as possible, most reports are split into 

sections with each section having a heading. 
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NEWSLETTER 

Newsletters are a less formal way of distributing information, such as to members 

of a club or society. Typically, newsletters use a column layout, 

as shown in Figure 15.58. For more information about column 

layouts,  

POSTER 

A poster is used to draw people's attention to something as they 

walk past it in the street or see it displayed on a notice board. A 

well-designed poster should not contain too much information, 

as people are unlikely to spend a lot of time reading it.  

 

 

Leaflet  

A leaflet is a document used to distribute information 

or advertise products or services. Like newsletters, 

leaflets use columns (see page 219), but in leaflets this 

layout is used to create a design that can be folded 

once the document is printed. This produces the effect 

of separate pages. 

Information sheets or fact sheets 

Information sheets and fact sheets usually contain more information than you would place on a poster, for 

example. They are designed to be handed out to people in the street as flyers, given out at meetings or left on 

information stands for people to pick up. 

 

An information sheet is usually a single, unfolded page, but they can be double-sided. The page size is usually set to 

A5 and the page orientation is often set to portrait. 
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Memo  

Memo is an abbreviation of the word memorandum and 

means a brief note or message. Memos are commonly used 

within businesses to convey information quickly and clearly. 

The language and tone used in memos is less formal than the 

language used in a letter. When you are creating a memo, it is 

conventional to specify the subject, as shown in Figure 15.62, 

to make it clear to the recipient what the memo refers to. 

 

MAIL MERGE 

Mail merge is used when you want to send the same document to 

many people but would like to personalise part of the document for 

each individual recipient. For example, you may want to add 

individual names and addresses to different copies of the same letter 

or to include personalised information in the text of a document, so 

that it appears to have been created for each recipient individually. 

Mail merge uses two files: 

☐ a data source 

☐ a main document. 

Chapter 16 – Graphics  
FEATURES OF IMAGE TYPES 

Graphic software can produce two types of images:  

■bitmap images 

■vector graphics. 

 

Bitmap images are used for photographs and scanned documents. 

They are made up of small squares called pixels. Each pixel is a tiny 

square of one single colour. Images that use more pixels are said to 

be higher resolution than images that use fewer pixels, meaning that 

the image is a better-quality image. This is shown in Figure 16.1. 
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Vector graphics  

Vector graphics do not pixelate when enlarged because they are made up 

of points or co-ordinates and lines. These are recalculated each time the image is redrawn, either by a printer or on 

a screen. Although vector graphics can look unrealistic or stylised when compared with bitmap images, they create 

much smaller files because data for each pixel does not need to be stored. 

 

Figure 16.4 shows the key difference between vector graphics and bitmap images. Because a bitmap image is made 

up of thousands of pixels, it pixelates when the viewer zooms in too far. The vector graphic does not pixelate 

because it is made of a series of simple mathematical co-ordinates, which means that, when the viewer zooms in, 

the image is accurately reproduced at a larger size. 

 

CREATE IMAGES 

When creating images, you must be able to combine basic shapes such as squares, rectangles, circles, ovals, 

triangles and arrows. 

Although you can use specialist graphics applications, many of these 

shapes are also available in applications that are not obviously 

associated with graphics, such as Microsoft Word. For more 

information about the shapes available in word processing 

applications, see page 229. Often, you can choose from a range of 

basic shapes or create your own from lines. You also need to be able 

to incorporate lines and text, including text boxes. 
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EDIT IMAGES 

Image editing tools allow you to change an image in a number of ways. 

Resize and rotate  

You can resize or rotate an image by clicking the image with your mouse to show its 

handles. These are the resize points and rotate points shown in Figure 16.10. 

 

 

 

 

 

 

Resizing an image by dragging the handles in the corners of the image 

maintains the image's aspect ratio. However, resizing the image by 

dragging the handles on the sides of the image does not maintain its 

aspect ratio, meaning that the image appears distorted. 
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Cropping 

Cropping an image means cutting off and deleting part or parts of it in order to make it a particular size or shape. 

For example, the image in Figure 16.12 has an original aspect ratio of 4:6. Figure 16.12 shows the image once it has 

been cropped to 5:7 and 8:10. 

 

Adding captions and text  

Text can be added to an image. For example, you might add a caption to a photograph or add a slogan or strapline 

to a logo. 

Editing or deleting unwanted parts of an image  

If there are areas of a bitmap image that you do not want, you can either erase them or recolour them so that they 

blend in with surrounding areas of the image. Figure 16.13 shows some of the tools available to do this in Microsoft 

Paint. 
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Chapter 17 – Presentation 
TEMPLATE AND MASTER SLIDE 

To ensure that your presentation has a consistent layout and 

design, you can use a template or theme. Figure 17.1 shows 

some of the templates available in Microsoft PowerPoint. 

 
 

All templates use the same group of slide layouts, some of 

which are shown in Figure 17.2, but each template has an 

individual design that is based on a master slide or slide 

master. The slide master content can only be edited using 

the Slide Master view, which is accessed in Microsoft 

PowerPoint by choosing Slide Master from the View tab. 
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Placeholders  

The slide master contains placeholders for 

content. These can be made available or 

unavailable by selecting Master Layout in the 

Slide Master tab. 

 
 

DATE AND TIME, FOOTER AND SLIDE NUMBER 

At the bottom of a slide layout, you can format the way in which 

the date and time, footer and slide number will appear on each 

slide. They will appear on the slides in your presentation if they 

are selected from the Header and Footer window after the 

Master View is closed, as shown in Figure 17.5. 

Background  

 

You can change the background of all slides using the slide master. You can add an image or background colour. 

You should always make sure that your text can still be read if you change the background colour or image (as 

shown in Figure 17.6). If you are using a light. 
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Font enhancement  

The fonts on the slide master or slide layout masters can be enhanced using formatting such as bold, italic or 

underlining. 

SLIDES 

Once you have set up your template and slide master, you can begin to add content to your individual slides. 

Text and images  

You can add text and images into the content placeholders on your slides. If you add a lot of text to a placeholder, 

the text will automatically resize so that it fits the placeholder. 

 

Try to limit the amount of text that you use on each slide. Presentations are not meant to repeat everything that 

the speaker says, but should give a few key points as a visual guide or reminder for the audience. If the audience is 

too busy reading lots of text on the slide, they may not be listening to what the speaker is saying. 

 

Sometimes, images can be much more powerful than words. You can even use images or charts to summarise the 

point or points that you are making on each slide without using any text at all. For example, compare Figures 17.10 

and 17.11. Both slides give the same information, but Figure 17.11 requires the audience to do less reading 

Action buttons  

Presentation applications can be used to create interactive 

navigation using action buttons. Figure 17.12 shows some examples. 

 

Action buttons have several uses 

 

If you are using buttons to allow users to navigate through your 

presentation, you might want to deselect the On Mouse Click setting 

from the Transitions tab. 

 

If you do not deselect this setting, users who control the presentation 

with a touch screen will find that pressing any area of the screen will 

cause the presentation to advance to the next slide.  
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Although this feature is only found in Microsoft PowerPoint, other applications also allow you to 

create buttons. For example, you can create buttons in LibreOffice Impress by using the Form 

Control menu, selecting the Push Button feature and setting a macro for that button. You can then 

make the macro control what should happen when the button is pressed. 

 

 
 

Hyperlinks  

During a presentation, you may want to open content from outside the presentation 

slides, such as a web page or a spreadsheet in a folder on your computer. You can insert a 

hyperlink to do this, as shown in Figure 17.19. 

Hyperlinks can open: 

■ local files 

■ online content 

■ slides in the current presentation or custom shows 

■ email addresses (used to compose a new email in the 

user's default email application with the address field 

already filled in). 

Hyperlinks can be added onto images or text, which is 

then clicked to access the hyperlink. 

Animations 

Animations are visual effects that add emphasis and movement. They are used to 

draw attention to important information, and they can be added to slide content 

such as text, pictures, shapes, tables, SmartArt graphics and other objects. Figure 

17.20 shows some examples of animation effects in Microsoft PowerPoint. 
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Transition  

Slide transitions are the effects that occur when a user moves from one slide to 

the next. 

 

The chosen transition and its settings are applied to the active or selected slide. 

You can also apply the same transition to all slides using the Apply To All 

functionality. Applying the same transition to all slides can improve the consistency of your presentation. 

 

PRINT 

If you need to print your presentation, there are several different print 

layouts available. Your choice will depend on the purpose of printing your 

presentation. 

Handouts 

Handouts are given to your audience so that they have a copy of the 

information that you are presenting. This can help your audience to 

follow your presentation more easily and allow them to take notes on the 

slides. 

Notes page  

When giving a presentation, you or the person speaking may need to 

refer to notes. Presentation applications provide a Speaker Notes section 

with each slide where you can add notes for the presenter, as shown in 

Figure 17.26. You can use this to add a complete script for the presenter 

to follow, or a few points that need to be explained. 
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Full page  

Choosing the Slides or Full Page Slides print layout gives 

the result shown in Figure 17.28. This print layout is 

useful if you want to create posters from the slides, 

which you can display. 

Headers and footers  

When printing your presentation, you can choose to 

print information in the header and footer, such as the 

time and date, slide numbers and a standard footer. You 

can do this by selecting Header/Footer or Edit Header & 

Footer in the Print settings and selecting the 

appropriate fields, as shown in Figure 17.29. 

 

 
 

Chapter 18 – Web authoring  
TEMPLATE 

Creating a template ensures that all of your web pages will have a consistent appearance and layout. Once you 

have created a template, you can add content and edit each 

page individually. 

 

Creating web pages by placing elements on a page rather 

than writing HTML is an example of what is known as 

WYSIWIG editing. This makes creating web pages much 

easier and has enabled more people to contribute to the 

World Wide Web.  
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Tables and frames  

Tables can be used to create a layout template, which specifies how content should 

be placed on a page. When the page is resized, the table will stretch to fit the page. 

This means that the page will keep its layout even when viewed on devices with 

different sized screens. 

Merging cells in a table allows you to create more complex layouts than using a simple grid. 

 

STANDARD PAGE FEATURES 

There are certain features that appear on most web pages, 

such as hyperlinks and menus. 

HYPERLINKS 

A hyperlink is a link that can be clicked in order to go to 

another location, often a web page hosted on a web server 

connected to the internet. You can insert hyperlinks that 

allow users to move to a position on a page in the current 

document, open documents from the current website or 

open documents from other online locations. This collection 

of linked content is known as the World Wide Web. 
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BACKGROUND COLOURS 

The background colour is the colour displayed as the background of a web page. You 

can also set an image as the background for a web page. If you do use an image, 

make sure that the colour of the text on the page contrasts well with the colour of 

the image. 

BANNERS 

Banners are promotional or marketing images that can be added to a web page, usually appearing at the top of the 

page. The image will often use the organisation's house style, but some banners advertise goods and services from 

other organisations. These are known as third-party banners. 

 

Banners can be created using different standard dimensions as shown in Figure 18.5. The leaderboard banner is a 

standard-sized banner (728 pixels wide and 90 pixels high) that can be placed at the top of a web page. Figure 18.6 

is an example of a leaderboard banner. 

 

PAGE NAME (FILE NAME) 

When you set up the template for your web page you named it 'index.html". This is because this name causes web 

browsers to load this page first by default, making it the first page that visitors to your website will see. In other 

words, 'index.html' will act as your website's home page. 

CONTENT 

The content of a web page can include text, images, buttons and animation. 

Text 

Text can be entered using either the keyboard or voice recognition software, just as when using other applications. 

You can format text using styles and alignment tools, which you will learn more about later in this chapter (page 

271). 

Images  

You can insert images such as banners and photographs into your web pages. When you do this, the web page 

creates a link to the location of the image. If you move the image to a different folder, the link may break and the 

image will not appear until you re-establish the link. 

You can either insert images using the Insert menu or by dragging and dropping the images into the document 

using the mouse. 
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ALT TEXT 

Alt text is alternative text that is displayed if an image cannot be loaded. When you add an image to a web page, 

you can specify the alt text that will be associated with the image, which can be displayed if the image cannot. For 

more information about alt text, see page 273. 

Buttons  

You can add hyperlinks to images to make them act like buttons. Users can click on the image to move around the 

page or to open other pages or documents, just as they can by clicking on hyperlinked text. 

Animation  

You can include animation files such as .swf files or animated .gif files in your web pages. These can be used to 

draw the user's attention to important content. 

 

FORMAT 

The content of a web page is formatted using styles and alignment. 

You can apply styles to headings, subheadings and body text in order to 

make their appearance consistent within the web page and across every 

web page in the website. For more information about styles, see page 218. 

Alignment  

You can align content left, right or centre. For more information about 

alignment, see pages 215 and 220. 

HTML 

You have already learned about some ways of using HTML, but there are other ways of using HTML you might use. 

You can write HTML in a simple text editor, as shown in Figure 18.14. 
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